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Installation & Upgrade 

Installation & Upgrade 
 

This Installation & Getting Started User’s Guide provides basic 
information about installing and setting up RI Club Administration 
Software (RI-CAS).  

Knowledge Base 

The information that you require for learning and using RI Club 
Administration Software (RI-CAS) can be found in an extensive 
Knowledge Base that is installed at the same time as the program.  
The Knowledge Base provides a detailed explanation of the software, 
step-by-step instructions and examples.  The Knowledge Base can be 
used as an online manual or sections can be printed to your computer 
printer if you require printed notes. 

 

The Knowledge Base can be opened from the Help menu or from the 
Knowledge Base icon found with the other RI Club Administration 
Software (RI-CAS) icons.  The Knowledge Base requires Adobe 
Acrobat Reader to be installed on your computer.   

Getting Support 

RI Club Administration Software (RI-CAS) provides technical 
support for users of its products.  Our preferred method of 
communication is email which effectively eliminates the time zone 
problems associated with our support and our customers being located 
all over the world. 



Installation & Getting Started User’s Guide 5 

Installation & Upgrade 

Many of you work with RI Club Administration Software (RI-CAS) 
at night at home. If a problem arises, the procedure would be to notify 
RI Club Administration Software (RI-CAS) of the problem by email 
(overnight) to clubadmin.support@rotaryintl.org and generally expect 
a response by the next business day.  RI Club Administration 
Software (RI-CAS) support will respond quickly by emailing you. 

Support is provided free. Continued free support can be obtained from 
the RI Club Administration Software (RI-CAS) web site 
https://riweb.rotaryintl.org.   
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What Type of Computer to Use 

RI Club Administration Software (RI-CAS) is a Windows program 
and requires Windows 95/98, Windows 2000 or XP.  The program 
will not work with Windows 3.11. 

RI Club Administration Software (RI-CAS) requires a Pentium level 
PC (Personal Computer) or higher with a minimum of 64 MB of 
memory and 50 MB of disk space.  Network installations require each 
workstation to meet the minimum PC ratings but the fileserver does 
not need any special considerations. 

RI Club Administration Software (RI-CAS) will only run on an 
Apple computer if that computer is capable of running Windows 32-
bit programs. 

Installing on a Single PC 

RI Club Administration Software (RI-CAS) will install automatically 
from the installation CD or file downloaded from the RI Club 
Administration Software (RI-CAS) web site in the same way as other 
Windows programs.   

Detailed step-by-step instructions for a stand-alone PC installation 
can be found in the installation section (see page 10). 
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Installing on a Network 

The procedure for installing on a network is different to installing on 
a stand-alone PC.  The installation will be carried out from each of the 
workstations that will use RI Club Administration Software (RI-
CAS).  No installation will carried out at the fileserver itself. 

The primary consideration for network installation is the level of 
permissions the user, who is installing RI Club Administration 
Software (RI-CAS), has to write to the network drives onto which you 
will install the shared RI Club Administration Software (RI-CAS) 
files and programs.  You will need to have sufficient permissions to 
create directories and write files on the selected network drive.  You 
will also need to be able to create icons on the workstation PC. 

Once installed each user needs to have sufficient permissions to write 
to their local hard drive and registry.  RI Club Administration 
Software (RI-CAS) creates temporary files on the workstation 
computer during operation and uses the registry to save user 
preferences and settings. 

Permission settings can be complex and incorrect setup can provide 
unusual error messages such as “Can’t find file” or “A RI Club 
Administration Software (RI-CAS) installation does not exist”.  
Please consult your network administrator to assist with installation. 

Detailed step-by-step instructions for network installation can be 
found in the installation section later in this chapter (see page 11). 
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Upgrade Preparation 

The Version 1.0 version of RI Club Administration Software (RI-
CAS) will automatically replace your Version 4.0, 5.0, and 6.0 
version and upgrade your database the first time you use the program 
after installation. 

Make sure you have made a backup of your database before installing 
RI-CAS 1.0   

Separate Secretary and Treasurer 
Version 1.0 can only work with Version 1.0 files.  If your club runs 
separate installations of RI Club Administration Software (RI-CAS) 
because of a separate secretary and treasurer then all installations 
must be upgraded before they can continue to share files. 

The version 1.0 upgrade can take place at any time.  There is no need 
to wait for a period end in the Treasurer module or for any functions 
to be completed in the Secretary module.   

Our recommendation is to wait until all installations of RI Club 
Administration Software (RI-CAS) can be upgraded before upgrading 
any.  The primary consideration is that each user has an adequate 
computer to run this software (see page 6). 

Each RI Club Administration Software (RI-CAS) installation can be 
upgraded independently using the same CD. 

. 
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After Installation 

A detailed Getting Started Checklist is available in the next section 
of this User’s Guide and a copy is included in the Knowledge Base.  
The Checklist provides a list of actions required for setting up and 
using RI Club Administration Software (RI-CAS) for the first time. 

It is important to complete the Checklist actions before using RI 
Club Administration Software (RI-CAS).  Some setup requirements 
will affect the results of reports and club profile statistics. 

A sample club database, The Rotary Club of Anytown has been 
installed with your RI Club Administration Software (RI-CAS) 
program.  You may find it useful to examine how this sample club has 
been setup as well as to try out new functions first before attempting 
these in your live club data. 

After Upgrading 
See page 20 for what to do after upgrading. 
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Installation 

Stand-Alone PC (Not connected to a network) 

Insert the RI Club Administration Software (RI-CAS) CD into your 
CD-ROM drive.  The Installation Menu should launch automatically.  

If the Installation Menu does not start, follow the steps below: 

1. Click on the Windows Start menu and select Run… 

2. In the Run dialog box, type the drive letter for the CD-ROM drive 
followed by a colon (for example D:) 

3. Click the Browse button.  In the Browse dialog box, click on the 
file named Setup.exe and click the Open button.   

4. In the Run dialog box, click OK.  The Installation Menu should 
appear. 

 

Click on the Install RI Club Administration Software (RI-CAS) 
button to start the installation.   

Note: that the Knowledge Base User’s Guide will be installed as an 
on-line document.  You may need to install the Adobe Acrobat 
Reader to read this document.  Install this after installing RI Club 
Administration Software (RI-CAS). 

 

Follow the on screen install instructions.  Select the New Club 
Administration Installation option from the screen shown below, if 
you have never installed this software before.  Otherwise, select the 
Upgrade Existing Version 5.0\6.0 option if you have version 5.0 or 
6.0 of the software. Use the New Club Administration Installation 
if you are running version 4.0. 
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During the installation you may be asked to re-start your computer 
before the install is complete.  Once Windows has restarted, if the RI 
Club Administration Software (RI-CAS) installation does not 
automatically re-start, you may need to start the installation process 
again by re-inserting the RI Club Administration Software (RI-CAS) 
CD and clicking on the Install RI Club Administration Software 
(RI-CAS) button. 

Network Installation 

A network installation or upgrade of RI Club Administration 
Software (RI-CAS) is always completed from the workstation PC.  
There is no installation carried out at the fileserver. 

From the first workstation PC start the installation process as 
described for the stand-alone PC above.  At the Installation Location 
screen (pictured above) select “New RI Club Administration 
Software (RI-CAS) Installation” if you have never installed this 
software before (or Upgrade if you have versions 5.0 or 6.0) and use 
the Installation Directory button to select a network drive location. 
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If you want to install RI Club Administration Software (RI-CAS) on 
additional PC’s connected to the same network run the same 
installation process at each PC.   

At the Installation Location screen select the Add New User to 
Existing RI Club Administration Software (RI-CAS) Installation 
option.  Use the Installation Directory button to point to the same 
network drive location that the previous RI Club Administration 
Software (RI-CAS) PC’s used.  Point to the Rotary International 
directory.  The install program will always add the “\rc” directory 
after the Rotary International directory. 

 

If you have not pointed to the correct directory on the network drive, 
or if you have insufficient permissions to read the required directory 
an error message will be displayed. 

 

Use the Installation Directory button to locate the correct directory or 
login as a user with administrator permissions. 

Note: Unless each network workstation installation points to the same 
RI Club Administration Software (RI-CAS) file on the same network 
directory, the installations will not be sharing the same database. 
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Uninstalling Version 1.0 

RI Club Administration Software (RI-CAS) Version 1.0 can have 
multiple clubs installed.  Clubs can be added and deleted using the 
Club function from the File menu (you will need the Administrator 
login to delete a club). 

To fully uninstall RI Club Administration Software (RI-CAS) 
together with all installed clubs use the Windows Add/Remove 
Programs function from the Control Panel. 

 

Re-Installing RI Club Administration Software (RI-CAS) 

Re-installing RI Club Administration Software (RI-CAS) will refresh 
the program files (which may have become damaged by a virus or 
some other program installation) and replace the Demo club database. 

To re-install and preserve your club registration and database use the 
installation instructions above and select the Add New User to 
Existing RI Club Administration Software (RI-CAS) Installation 
option. 
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Adding or Upgrading Clubs 
The Club function, found in the File menu, is where you will register 
your club in RI Club Administration Software (RI-CAS) or select and 
upgrade a Version 1.0 club. 

 

Using the Club menu you are able to open and close clubs as well as 
create a new club or delete a club. 

Select the New Club sub-menu to add a new club or the Open Club 
sub-menu to select a club for upgrade.   

  

 

 

Open your 
club’s database 
to begin the 
upgrade. 
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Type the name of the new club. Do not add any spaces or punctuation 
to the name. 

Click on the Continue button.  You should move to the next screen in 
the registration process.  Type in a suitable name for the directory to 
which RI Club Administration Software (RI-CAS) will install the new 
club.  This directory will be automatically created under the RI Club 
Administration Software (RI-CAS) directory in the location of your 
RI Club Administration Software (RI-CAS) programs and files. 

Click on the Continue button to create a club or start the upgrade. 

Starting RI Club Administration Software (RI-CAS) the First 
Time 

The first time you login to RI Club Administration Software (RI-
CAS) after registration, the login User Name field will be set to “User 
1” and “rotary” as the password . 
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Click OK. 

The new or upgraded club is now registered and will open with the 
club name displayed in the middle of the screen. 

Add Users 

If you want to record the names of the people who will operate RI 
Club Administration Software (RI-CAS) you will need to add Users.  
RI Club Administration Software (RI-CAS) logs the changes made to 
the database by each User, which may be useful for checking errors.  
You can also skip adding Users and continue to use the “User 1” login 
each time you use RI Club Administration Software (RI-CAS). 

Administrator Login 

Each time you login in to RI Club Administration Software (RI-CAS) 
you will be presented with a list of User Names which includes those 
you have added as well as the Administrator login.   

The Administrator login should only be used if for some reason you 
have forgotten the password for the other login names or cannot login 
because of a problem with your database. 

The password for Administrator is always “rotary”, unless changed 
by you. 

The “Administrator” login can not be used to operate RI Club 
Administration Software (RI-CAS).  The menu and button bar buttons 
will be inactive.  The Administrator is only able to edit Users. 
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To add the names of the people who will use RI Club Administration 
Software (RI-CAS) in your club, open Define Users from the Setup 
User menu. 

 

From the list of Users shown, click the buttons on the Toolbar to add, 
save and delete users.   

 

 

 

 

 

 

 

 

 

 

Toolbar 
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Click on the New button to add each user name.   

 

Type a password and select the security level. 

Standard -Normal user – can use both Secretary & 
Treasurer modules. 

Database Only -Can use the Secretary module only. 
Administrator -“Standard” plus able to edit and add users. 
Read Only Both -Can “see” but not change both modules. 
Read Only  -Can “see” Secretary module only. 

If you do not wish to type your password each time you login to RI 
Club Administration Software (RI-CAS), click the Remember 
Password checkbox. 

Close the Define Users screen and Close the club.  Then Open the 
club again.  This time you will be able to login with one of the new 
user names you have created and all the RI Club Administration 
Software (RI-CAS) functions will be active. 

The Return Email 
Address is used in 
RI-CAS Online. It 
is inactive in the 
desktop version. 
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After Upgrading 
RI Club Administration Software (RI-CAS) Version 1.0 has some 
new options not available in earlier versions.  You may wish to update 
your database to be able to use these. 

Club Structure 

Club Structure saves a layout of the positions and committees for 
your club for each Rotary year.  The layout makes it easier when 
assigning members into positions and for reporting.  Setup the Club 
Structure for the current year, then as each past or future year is 
opened for the first time the structure you have built can be copied.  
You will find Club Structure in Club Setup, found under the View 
menu or in the Position Assignment function. 

Photo Database 

Version 1.0 stores member photos inside a separate Archive & Photo 
database.  Member’s photos are automatically copied to this database 
during the upgrade.  It is now possible to transfer the Archive & 
Photo database to the treasurer and any other copies of RI Club 
Administration Software (RI-CAS) run by your club using the 
Backup and Restore functions.  Due to the size of the photo database 
file it may be necessary to use a CD burner to complete the transfer. 

Newsletter Preferences 

Each member (and non-member) now can have a preference setup for 
how they would like to receive the club’s newsletter.  The preference 
is setup in the Club section of each member’s record.  To use the 
preference for sending newsletters you will need to create Filters that 
select members based on the newsletter preference fields.  The filters 
will use the new options found within the Club fields of the Filter 
setup. 
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Partner’s Salutation 

A new field for partner’s salutation can be used when sending emails.  
This field needs to be completed before it can be used. 

RI Languages 

The “official” RI Languages codes have been added to Club Setup.  
These language codes need to be added to each member in the 
Personal section of a member’s record under the Other Details 
button. 

RI Occupation Codes 

The “official” RI Occupation codes have been added to Club Setup.  
These occupation codes need to be added to each member in the 
Personal section of a member’s record under the Other Details 
button. 

Auto Makeups Preference 

Version 1.0 includes the automatic assignment of makeups to missed 
meetings.  This works for the makeups you enter (click an Automatic 
button) or for the makeups created by the Events function.  The way 
RI Club Administration Software (RI-CAS) assigns makeups can be 
controlled in the Auto Makeup section found under the Preferences 
menu. 

Attendance Worksheet Preference 

There are new options for the printed worksheet used for checking 
attendance at the door of your meetings.  The options can be changed 
using the Attendance Worksheet section found under the 
Preferences menu.  Note, if the Honorary Members option is 
unchecked, Honorary members will not be included in the list of 
members included with each meeting. 
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Filter Folders 

New Filter Folders allow filters to be collected into useful groups 
rather than in one long list.  You may wish to add Filter Folders and 
re-organize your filters. 
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24 Installation & Getting Started User’s Guide 

Getting Started Checklist 

Getting Started Checklist 
 

Use this Checklist as your guide to setting up RI Club Administration 
Software (RI-CAS).  The Checklist steps will point to the appropriate 
sections of the Knowledge Base where detailed instructions can be 
found.   

Knowledge Base 

 

The Knowledge Base is a complete User’s Guide and was installed 
when you installed RI Club Administration Software (RI-CAS).  It 
can be opened from the Help menu or from the Knowledge Base icon 
found with the other RI Club Administration Software (RI-CAS) 
icons.  The Knowledge Base requires Adobe Acrobat Reader to be 
installed on your computer.   

Be sure to contact the RI Club Administration Software (RI-CAS) 
support clubadmin.support@rotaryintl.org if you have any questions.  
We are here to help you understand this software and get the full 
benefits it can bring to your club. 

Secretary Module 
The Secretary Module is a database of people that includes your 
members, past members, potential members and others.  Although 
named "Secretary Module" the club secretary does not normally run 
this program.   
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Any person who has the time can maintain the club’s records stored in 
RI Club Administration Software (RI-CAS).  

The results of keeping your club records up-to-date can then be shared 
with other club officers, including the secretary. 

Copies of your club database can be regularly sent to other club 
officers as an email attachment.  In this case you would send a Data 
Transfer file which would be “retrieved” by the receiver.  

Reports can be exported from RI Club Administration Software (RI-
CAS) in a number of formats and sent as an email attachment or even 
published on your club’s web site. 
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Setup Steps for RI Club Administration Software (RI-CAS) for 
Rotary Clubs 

Once you have installed RI Club Administration Software (RI-CAS), 
completed the registration and created users, all explained in the 
previous section of this guide, you should follow the following steps 
to set your club up: 

Step 1 – Setup Club Meeting Day 

 

In Club Setup, found under the View menu, select the meeting day 
from the first tab Club Details.  All other entries in Club Setup can be 
entered later but the meeting day is important for the attendance 
functions.  Refer Chapter 3 Setup Club & Preferences for more 
details. 

Step 2 – Setup Positions & Committees 

In Club Setup, found under the View menu, the third tab 
Descriptions add and change club positions and committees to suit 
your club.  Refer Chapter 3 Setup Club & Preferences. 

Step 3 – Setup Club Structure 

In Club Setup, found under the View menu, the third tab 
Descriptions click on the Club Structure button to establish how 
positions and committees should be structured. Refer Chapter 3 Setup 
Club & Preferences. 

Step 4 – Import Data 

If you have no data to import go directly to Step 5. 
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Your club member information can be imported into RI Club 
Administration Software (RI-CAS) from other software (including an 
extract of your data available from the RI database, check with RI).   

When importing data from a non-RI Club Administration Software 
(RI-CAS) source the import file should include the member’s last 
name. 

Import from a non-RI Club Administration Software (RI-CAS) source 
is discussed in Chapter 33 Import Export. 

Step 5 – Add Member Records 

 

Now that the club has been setup in RI Club Administration Software 
(RI-CAS) you can finally add your members. 

Two fields are particularly important in every member’s record. the 
Member Type and Date Joined fields determine “who” is included 
when creating meetings in the Attendance function.  Chapter 7 
Member Database for more details on adding members to your 
database. 
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Step 6 – Edit Name Format Preferences 

 

Name Formats are where you establish how RI Club Administration 
Software (RI-CAS) will display people’s names for the different 
situations where names are used.  Refer Chapter 3 Setup Club & 
Preferences. 
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Treasurer Module 
The Treasurer Module is designed to manage the income and 
expenses for a Rotary club.  This is a full accounting system that is 
normally run “stand-alone” on a separate computer to the Secretary 
Module.  A Data Transfer function allows updated member 
information to be sent to the treasurer from time to time so that the 
treasurer doesn’t need to duplicate work already done. 

Install RI Club Administration Software (RI-CAS) on the computer 
used by the treasurer and follow these setup steps: 

Step 1 - Starting date 

RI Club Administration Software (RI-CAS) will look at your 
computer’s date and set the starting date for your accounts as July 1st 
of the current Rotary year (July 1st to June 30th).  If you would like to 
load balances and transactions into the previous year, you must 
change your computer’s date to June 30 or before of the previous 
Rotary year before creating your club database. 

If you have already created your club and wish to change to an earlier 
start date, you must delete the club and create it again with the 
computer date set as outlined above. 

Step 2 - Accounting format 

Accounting Formats, found under the Club menu, defines the layout 
of  your Chart of Accounts.  There are two options one with Income 
accounts first and one with Asset accounts first.  Select the option you 
wish to use.  This selection can be changed at any time. 

The “US” format lists Asset & Liability accounts first and the “Other” 
format lists Income & Expenditure accounts first.   
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Step 3 - Setup Chart of Accounts 

Add and change the accounts you wish to use for your club’s 
accounting system.  New accounts can be added at any time however 
it is a good idea to decide on an accounting structure as early as 
possible.  Refer to Chapter 28 Chart of Accounts. 

Step 4 - Setup additional Entities 

If your club runs a separate trust or foundation then you can setup a 
new entity and Chart of Accounts for this.  Refer to Chapter 5 Setup 
Accounting. 

Step 5 - Setup taxes 

If your club needs to account for either sales tax or GST/VAT style of 
tax use Tax Code Setup found under the Club menu. 

Step 6 - Setup projects 

Projects are how RI Club Administration Software (RI-CAS) takes 
care of fundraising activities and charitable donations.  Create a 
separate project for each activity.  Refer to Chapter 24 Club Projects. 

Step 7 - Load opening balances 

Opening balances are the closing Balance Sheet balances from your 
last set of (non RI Club Administration Software (RI-CAS)) accounts.  
Refer to Chapter 6 Setup Opening Balances in the Knowledge Base 
for detailed instructions.  Loading opening balances requires some 
double-entry accounting skills and we recommend you obtain 
assistance to ensure this important setup phase is correct. 
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Overview 
RI Club Administration Software (RI-CAS) is a great way to get your 
Rotary club better organized.   

This is a software system that lets you know what’s going on in your 
club because it is so easy to collect information and introduce 
consistent reporting.  RI Club Administration Software (RI-CAS) 
reduces the time it takes for administrative chores, it helps your 
members to collaborate, share duties and work as a team.  RI Club 
Administration Software (RI-CAS) can even let your club make better 
use of the Internet.  

RI Club Administration Software (RI-CAS) can be run as either a 
desktop system installed on a PC or as an Internet hosted program 
together with special software that allows members to login to your 
Rotary club. 

What is RI Club Administration Software (RI-CAS)? 

RI Club Administration Software (RI-CAS) is software written 
specifically for the management of a Rotary club.  This overview 
describes the major parts of the system. 

 

So let’s login and take a tour of the system known as RI Club 
Administration Software (RI-CAS).   

It all starts with the people in your club.  Their information sits in a 
database of members, which can be displayed in many different ways 



32 Installation & Getting Started User’s Guide 

Overview 

using the RI Club Administration Software (RI-CAS) “Member 
Grid”.  

 

The Member Grid 

The Member Grid is a very useful tool when dealing with lists of 
people such as members of a Rotary club.  

 

It allows you to see and edit your member information in a 
“spreadsheet like” view, which is fully changeable by you.  You can 
decide which of your member information is listed in columns, how 
the members are sorted, who is included and how they are grouped. 
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Behind each “row” in the Member Grid is a member database record 
that contains all the information on each member (see next page).  
The Member Grid will display just the information you want to see 
for whatever purpose you have and you can save the layout in a View, 
which can be re-used. 

Any group selected from the Member Grid can be instantly sent a 
message by email (or print a letter).  But more importantly, the 
message will be sent using the member’s preferred “message by” 
method.  The Member Grid toolbar contains buttons that bring up the 
communications tools.  These are explained later in this overview. 

 

The Database 

Members (past, present or potential) are stored in a database that is set 
out in a format, which provides for the natural separation of 
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information into personal, business, family and so on.  Each section is 
displayed and used by clicking on the appropriate “tab”.  A member’s 
personal record and photograph area looks like this: 

 

RI Club Administration Software (RI-CAS) provides a complete 
record of information for each of your members, although it is not 
necessary to enter it all.  As well as the usual contact and personal 
information such as address and contact numbers, there is also a 
comprehensive list of Rotary information.  This includes 
classification, RI membership numbers, a complete history of 
positions held and past membership of other clubs. 
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Meetings & Attendance 

RI Club Administration Software (RI-CAS) has a complete 
attendance and make-up management system, which can be run by a 
member on a separate computer and integrated into the club’s master 
database. 

Meetings are created according to your club’s meeting day and RI’s 
attendance rules in the Attendance function. 

 

Members will be added to a meeting when it is created based on their 
attendance status.  Attendance statistics, for each member and the 
club, are automatically generated as the meeting attendance is entered.   
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Meals and guests can be added for reporting summaries but also for 
billing purposes in the Treasurer's module.   

Remote Attendance 
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A meeting created in RI Club Administration Software (RI-CAS) can 
be exported to another computer, or a Palm handheld computer, as a 
file. 

Attendance for the exported meeting file can be completed on the 
other computer at the door of your meeting, then re-imported back 
into RI Club Administration Software (RI-CAS).  This function is 
useful when you run RI Club Administration Software (RI-CAS) 
online or if a different person manages the attendance records for your 
club. 

Make-up Manager 

The Make-up Manager provides a fast method of entering make-ups 
and having these automatically applied to any meeting missed by the 
member.   

 

All attendance statistics are available in comprehensive Attendance 
and Meeting reports as well as the District report. 
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The Attendance Queries screen has been designed to allow an easy 
way to view the current state of member and club attendance 
statistics.  There are two screens, the Current tab provides details of 
the current year, while the Historical tab provides attendance history 
for each member for up to 100 years. 

Communications 

Communicating with your members is fast and very easy with RI 
Club Administration Software (RI-CAS).  You will mostly 
communicate using email but the same message can be printed as a 
letter for those members who cannot receive emails. 

RI Club Administration Software (RI-CAS)’s unique licensing allows 
as many of your members as needed to run a copy of the software.  
The communication features can be used by different club officers for 
different reasons.  They can quickly obtain an up-to-date copy of the 
member database as an email attachment or download from your web 
site. 

Sending a message, which can include for example the distribution of 
your newsletter, is as easy as selecting a group of people from the 
Member Grid and clicking on one of the two message buttons on the 
toolbar. 



Installation & Getting Started User’s Guide   39 

Overview 

 

You can create message “templates” by re-using the contents of 
previous messages. 

The letter option produces fully merged letters without any of the 
difficulties of mail merge.  It is also possible to export a file from RI 
Club Administration Software (RI-CAS) using the Export function 
and create your own merged letters using Word or any word 
processing package. 

Events 

In addition to your regular meetings, RI Club Administration 
Software (RI-CAS) can keep track of other events such as committee 
or board meetings as well as fellowship activities.  Attendance at 
events can create automatic makeups for members. 
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The Events function allows the date, time and location of any club 
event to be recorded.  There is an option to record attendance by 
members, guests and to note any event charges.  Event attendance, 
guests and event charges can be “seen” by the Treasurer” module for 
billing purposes. 

 

If your club uses RI Club Administration Software (RI-CAS) Online, 
events can be “seen” by members when they log into the Member 
Access Portal.  Using this facility the club can start to collect event 
attendees, apologies and a guest list for an event before it happens. 
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An event attendance worksheet can be printed to collect actual 
attendance during the event and comprehensive event attendance 
reports allow your club to manage this area more easily.  

Club Officers 

The Position Assignment function is a tool to easily create the 
positions and committees for the next Rotary year before the year 
begins.  The History buttons pop up a list containing the history of all 
previous club positions held by a member, or the history of all 
members who have held a particular position.  This information is 
useful when making the position assignment decisions. 
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Club Structure 

Club Structure saves a layout of the positions and committees for 
your club for each Rotary year.  The layout makes it easier when 
assigning members into positions and for reporting.   

 

Using Position Assignment together with the Club Structure function 
your president elect has a great set of tools to develop the “team” well 
before the next Rotary year starts.   
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RI Roster 
The RI Roster works with your club's RI Club Administration 
Software (RI-CAS) database and allows you to create your roster (or 
directory of members) in any format, page size, field selection and 
photo position.  Once created you can print the roster or you can 
export the roster as a PDF file for import and finishing by your 
commercial printer or publishing consultant.  This program should 
take thousands of dollars off the cost of producing your roster.   

 

 

 

 

 

 



44 Installation & Getting Started User’s Guide 

Overview 

 

 

Reporting to RI & District 

Member information can be sent to RI (and district) with the click of a 
button. 

 
 

 

 

 

 

 

RI Club 
Administration 
Software (RI-CAS) 
automatically creates 
an email containing 
the member’s details 
requested by RI for the 
option selected. 
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In addition to the method described above, RI Club Administration 
Software (RI-CAS) also has the Monthly District Email that sends all 
attendance and membership information required by district in an 
electronic format that they can use. 

The information required to be sent in the RI Semi-Annual Return 
can be extracted from RI Club Administration Software (RI-CAS) and 
printed in the RI format.  The report for New and Terminated 
members can be sent directly to RI, the member change information 
must still be manually added to the report sent by RI. 

Invoicing & Accounts Receivable 

RI Club Administration Software (RI-CAS) has a complete billing, 
accounts receivable and accounting system integrated to your member 
database.  A unique and highly specialized function, Multiple 
Invoicing, can prepare an unlimited number of member invoices in a 
few minutes.  As Rotary clubs tend to create invoices in bulk, with 
many of the invoices similar or identical the Multiple Invoice function 
often saves many hours of administration time.  You will find it very 
easy to understand and use. 

RI Club Administration Software (RI-CAS) can also be integrated 
into other accounting systems using the Transaction Extract function.  
If you choose to use another accounting package, then it is a very 
good idea to complete member invoicing and receipting within RI 
Club Administration Software (RI-CAS) then manage the remainder 
of your accounting with the other accounting system. 

Multiple Invoice 

The Multiple Invoice function is able to generate and print many 
invoices in one operation.  An invoice is generated for each record 
selected using a “select” procedure. 
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An unlimited number of invoice charges can be setup and selected to 
be included on each invoice.  Invoices can be posted as either real or 
proforma.  Proforma invoices are tracked, but no accounting takes 
place until the invoice is actually paid – cash basis. 

Once invoices (real or proforma) are printed and posted an accounts 
receivable record is created for each member.  This is a business level 
system and can be used to manage many more charges besides 
membership dues.  For example events, fundraising receipts and 
donations can be managed with this system. 

The Aged Trial Balance is a report listing all members who have an 
amount outstanding, either debit or credit.  The amounts are analyzed 
into 30 or 90 day periods based on the date of the transaction and if 
you operate on a quarterly basis or not.   

Email Invoices & Statements 

Save money on postage and an enormous amount of your Treasurer’s 
time by combining the unique Multiple Invoice function in RI Club 
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• In the Treasurer Module setup 
each member’s preference for 
receiving invoices & statements by 
email or regular mail. 

 

• In Multiple Invoice, invoices for 
all your members can be completed 
in under 1 minute. 

The system detects which 
invoices to email and those to 
print (for regular mail). 

Administration Software (RI-CAS) with a simple bulk email.  It 
works like this: 
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• A bulk email is 
automatically created and a 
custom invoice sent to each 
member. 

 

• Invoices can be 
changed and reprinted or 
re-emailed at any time. 

 

• Statements can be sent 
just as easily. 

 
Sending out invoices and statements by email can be a big time-saver 
for your club because there is no need to print and mail invoices ever 
again.  

Cashbook & Accounts Payable 

If you use another accounting system, invoicing and receipt 
transactions can be extracted and summarized for fast entry into these 
systems. 

Alternatively you can use the RI Club Administration Software (RI-
CAS) Cashbook & Accounts Payable section, which is designed to 
manage cash movement in and out of multiple bank accounts and 
produce detailed financial reports for the treasurer.  There are three 
data entry functions: 

- Receipt    -cash receipts 
- Vendor Bills & Payment  -accounts payable and cash payments 
- Bank Transfer   -transfer funds between bank accounts 
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There is also a Bank Reconciliation function that provides a tool to 
reconcile cash transactions against the bank statements, while at the 
same time, providing a data entry tool for many transactions that 
originate from the bank statement. 

Cash transactions can be analyzed from the organization’s point of 
view and also from a member’s point of view using the Member 
Tracking functions. 

Example of Payment Allocation screen: 

 

The RI Club Administration Software (RI-CAS) accounts payable 
system can allow vendor’s bills to be entered immediately on receipt 
and checks (cheques) can be printed from RI Club Administration 
Software (RI-CAS) using pre-printed stationery.  Full accounts 
payable management reports provide a complete system suitable for 
larger Rotary clubs. 

If your club still uses a manual check writing system, then these can 
be entered directly as expenses and the accounts payable system 
simply bypassed. 
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General Ledger & Financial Reporting 

The General Ledger is built around a chart of accounts which has 
been standardized to be as close as possible to a typical Rotary club’s 
requirements.  Accounts can be added, edited or deleted from the 
chart of accounts by each club to complete the process.   

The General Ledger has the ability to easily separate club and 
charitable funds by the creation of projects.  Projects can be added to 
transactions providing increased analysis and profit reporting by 
fundraising activity. 

Financial budgets can be entered for each of the income and 
expenditure accounts in the chart of accounts using the Budget 
function.  The budgets can be broken down into monthly amounts and 
used as a comparison against actual results. 

Financial reports include a series of income and expenditure reports, 
balance sheet and other General Ledger analysis reports.  The 
treasurer has cash movement analysis reports to manage clubs funds.  
Detailed audit trail reports provide a tool for the club’s auditor or for 
analysis if things go wrong. 

The View Transactions function displays transactions by period and 
type and allows a “drill down” to the underlying documentation. 
Transactions can be deleted and some non-essential parts edited but 
RI Club Administration Software (RI-CAS) has sought to maintain 
financial integrity by forcing an Audit Trail to be recorded whenever 
transactions are changed after they have been posted. 

Financial Periods 

The RI Club Administration Software (RI-CAS) accounts run from 
July 1st through June 30th with July period 1 and June period 12. The 
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software keeps track of the current period and allows accounting 
transactions to be entered into any period of the current year. 

The Year End function will close the financial year and transfer the 
operating result to the retained earnings account. Invoice numbers are 
reset to 1 and transactions more than two years old are deleted. Once 
the financial year is closed transactions can be posted to, and reports 
printed from, the previous year to allow the final accounts to be 
prepared after the new year has started. 

 

Data Sharing & Teamwork 

In many Rotary clubs different people carry out the duties of 
preparing and maintaining the club’s information.  For example 
attendance is recorded by one member and the member database 
maintained by another.  Usually the treasurer is separate person again.  
Sometimes a club would like to split these duties but can’t. 

Often many different people need to use the club’s information for 
various reasons.  For example the membership chair wants to see 
member attendance history or the sergeant-at-arms needs to check 
anniversary dates. 

RI Club Administration Software (RI-CAS) has two important design 
considerations to assist the sharing of duties and information between 
club officers and members; 
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The Data Transfer function is a very powerful utility that is able to 
extract and synchronize member information transferred between 
copies of the club’s database. 

 

RI Club Administration Software (RI-CAS) Online and the Member 
Access Portal is a service that hosts your club’s database on a secure 
server managed by Rotary International. Your club officers can access 
the database and use the RI Club Administration Software (RI-CAS) 
software over the Internet.  Individual members can also login to your 
Rotary club using the unique Member Access Portal and take 
responsibility for managing their own database record, view a club 
roster, check their account and even manage a committee.  
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The Data Transfer function allows your club to better operate as a 
team by enabling the sharing of duties and information. 

 

Computer Requirements 

RI Club Administration Software (RI-CAS) software runs on IBM 
compatible PC computers.  The minimum configuration will be a 
Pentium processor with 64 MB of RAM memory.  At least 50 MB of 
hard disk space must be available.  A high speed fax/modem 28.8K or 
above will be necessary to send email or fax or to connect with RI 
Club Administration Software (RI-CAS) Online. 

RI Club Administration Software (RI-CAS) will not run on Apple 
computers unless they are of a late model and are capable of running 
Windows software.  However Apple computers are able to use RI 
Club Administration Software (RI-CAS) Online. 

Multi-User Network Ready 

RI Club Administration Software (RI-CAS) is a multi-user network 
ready system.  The software can be installed on a network drive and 
shared by concurrent users.  
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